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ВВЕДЕНИЕ  

Автоматизированное формирование текстовой конструкторской документации на изделие1 в соответствии 

с требованиями ГОСТ выполняется в системе Altium Designer расширением (Extension) GOST 2.701-

2008/2.106-1996 (далее по тексту – расширение GOSTBOM). 

 

Расширение GOSTBOM версии 1.0.x доступно в Altium Designer версий с 15.0.7 по 17.1.9. 

Расширение GOSTBOM версии 2.0.x доступно в Altium Designer версии 19.0.10 и более новых. 

Расширение второй версии разработано заново и является полной заменой предыдущей версии. 
 

 Техническая поддержка и сопровождение 

При возникновении вопросов с установкой и эксплуатацией расширения GOSTBOM, рекомендуется 

придерживаться следующей последовательности действий: 

 Обратитесь к данному руководству и попробуйте найти решение возникшего вопроса. 

 Обратитесь к разделу Часто задаваемые вопросы настоящего руководства. 

 Обратитесь в службу технической поддержки компании Altium через Центр Поддержки. 

 Назначение расширения 

Расширение GOSTBOM предназначено для автоматизированного формирования текстовых 

конструкторских  документов следующих видов: 

Вид документа Нормативный документ правила выполнения  

Перечень элементов ГОСТ 2.701-2008 

Групповой перечень элементов ГОСТ 2.701-2008, ГОСТ 2.113-75 

Спецификация ГОСТ 2.106-96, ГОСТ 2.413-72 

Групповая спецификация вариант А ГОСТ 2.106-96, ГОСТ 2.413-72, ГОСТ 2.113-75 

Ведомость покупных изделий ГОСТ 2.106-96 

Групповая ведомость покупных изделий ГОСТ 2.106-96, ГОСТ 2.113-75 

Цель автоматизации проектирования – снижение затрат времени формирования и повышение качества 

выпускаемой документации. 
 

Особенности работы расширения GOSTBOM: 

 текстовые документы формируются из проектных данных, где файл проекта платы (*.PrjPcb) 

содержит данные о реквизитах основной надписи текстовых документов, файл ActiveBOM 

(*.BomDoc) содержит данные о компонентах, такие как позиционные обозначения и параметры; 

 сформированные документы не имеют интерактивной связи с источниками данных, поэтому в 

случае изменения состава изделия требуется повторное формирования документов; 

                                                        

1 Изделие  ̶  в контексте документа понимается: электронный модуль на базе печатных плат. 

 

Расширение GOSTBOM версии 2.0.x, установленное в Altium Designer версии 19.1.5 и выше, также делает 

доступными в редакторе чертежей Draftsman графические элементы оформления по ГОСТ, такие как: 

 Упрощённый вид структуры печатной платы с линией разрыва 

 Значения наличия металлизации в таблице отверстий на русском языке  

 Абзацный отступ и формат нумерации в технических требованиях (объект Note) 

 Определение префикса для текста выноски 

 Символы пайки и приклейки 

 Знак маркировки и клеймения 

 
Заявки на новые необходимые функции в расширении GOSTBOM принимаются через портал Ideas.  

https://altium-ru.com/
https://www.altium.com/ru/support
http://docs.cntd.ru/document/1200069439
http://docs.cntd.ru/document/1200069439
http://docs.cntd.ru/document/1200001994/
http://docs.cntd.ru/document/1200164121
http://docs.cntd.ru/document/1200006930/
http://docs.cntd.ru/document/1200164121
http://docs.cntd.ru/document/1200006930/
http://docs.cntd.ru/document/1200001994/
http://docs.cntd.ru/document/1200164121
http://docs.cntd.ru/document/1200164121
http://docs.cntd.ru/document/1200001994/
https://bugcrunch.live.altium.com/#Ideas/New
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 текстовые документы формируются в файлы формата Microsoft Excel® (*.xls); 

 Глоссарий 

В документе приняты следующие термины и определения: 

расширение (Extension): Программный модуль для расширения базовых функциональных возможностей 

Altium Designer. 

электронный модуль нулевого уровня; ЭМ0: Электронный модуль, выполненный на основе изделий 

электронной техники и электротехнических изделий, размерно координируемый с базовой несущей 

конструкцией первого уровня радиоэлектронного средства [ГОСТ Р 52003-2003, статья 19]. 

программное обеспечение: Совокупность компьютерных программ и программных документов, 

необходимых для эксплуатации этих программ. [ГОСТ Р 51904-2002, статья 3.10]. 

реквизит документа: Элемент оформления документа, содержащий о нём сведения. Примечание – Как 

правило, реквизит состоит из атрибутов (составной реквизит). [ГОСТ 2.104-2006, статья 3.1.1] 

атрибут документа: Идентифицированная (именованная) характеристика части реквизита. [ГОСТ 2.104-

2006, статья 3.1.2] 

оформление документа: Заполнение реквизитов и атрибутов, установленных правилами 

документирования. [ГОСТ 2.104-2006, статья 3.1.1] 

иерархический проект: Проект, который имеет родительски-дочерние отношения между листами, 

представление схемы реализованное по функционально-узловому принципу. 

обозначение элемента (позиционное обозначение): Обязательное обозначение, присваиваемое 

каждой части объекта и содержащее информацию о виде части объекта, её номер и, при необходимости, 

указание о функции данной части в объекте. [ГОСТ 2.710-81, приложение 2, пункт 3, таблица 2, пункт 3] 

элемент схемы: Составная часть схемы, которая выполняет определённую функцию в изделии (установке) 

и не может быть разделена на части, имеющие самостоятельное назначение и собственные условные 

обозначения. [ГОСТ 2.701-2008, статья 3.5] 

функциональная группа: Совокупность элементов, выполняющих в изделии определенную функцию и не 

объединенных в единую конструкцию. [ГОСТ 2.701-2008, статья 3.7] 

данные: Информация, представленная в виде, пригодном для обработки автоматическими средствами при 

возможном участии человека. [ГОСТ 15971-90, статья 1] 

база данных: организованная в соответствии с определёнными правилами и поддерживаемая в памяти 

компьютера совокупность данных, характеризующая состояние некоторой предметной области и 

используемая для удовлетворения информационных потребностей пользователей.  

[ГОСТ 2.054-2013, статья 3.1.1] 

  

 
Для формирования текстовых документов с помощью расширения GOSTBOM установка Microsoft 

Excel на вашем компьютере не требуется.  

https://altium-ru.com/
http://docs.cntd.ru/document/1200031280
http://docs.cntd.ru/document/1200030195/
http://docs.cntd.ru/document/1200045443
http://docs.cntd.ru/document/1200045443
http://docs.cntd.ru/document/1200045443
http://docs.cntd.ru/document/1200045443
http://docs.cntd.ru/document/1200001985
http://docs.cntd.ru/document/1200069439
http://docs.cntd.ru/document/1200069439
http://docs.cntd.ru/document/1200015664
http://docs.cntd.ru/document/1200115350
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В документе приняты следующие сокращения: 

ПЭ3 – перечень элементов 

ВП – ведомость покупных изделий 

КД – конструкторская документация / конструкторский документ 

Э3 – схема электрическая принципиальная 

GUID – Globally Unique Identifier (Глобально-уникальный идентификатор) 

 

https://altium-ru.com/
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2  УСТАНОВКА И НАСТРОЙКА РАСШИРЕНИЯ  

Для формирования текстовой документации по ЕСКД в Altium Designer необходимо произвести установку и 

настройку расширения. 

 

Расширение GOSTBOM не устанавливается вместе с Altium Designer по умолчанию, а устанавливается 

пользователем при необходимости.  Установка и настройка расширения выполняется пользователем с 

правами администратора. 

 Установка расширения 

Установка/обновление расширения производится на странице Extensions & Updates Altium Designer 

(команда Extensions and Updates из меню пользователя – ). 

Для установки расширения переключитесь на вкладку Purchased, найдите иконку 

GOST 2.701-2008/2.106-1996 и нажмите на кнопку . После установки расширения необходимо 

перезапустить Altium Designer. 

 
Рисунок 2.1 – Страница установки доступных расширений 

После перезапуска Altium Designer иконка расширения отобразится на вкладке Installed страницы Extension 

& Updates.  

 

После установки расширения, при доступности его более новой версии, иконка GOST 2.701-2008/2.106-

1996 появится на вкладке Updates страницы Extensions & Updates. Наведите курсор мыши на кнопку 

загрузки, чтобы увидеть информацию о версии. Щёлкните левой кнопкой мыши по заголовку расширения, 

чтобы получить более подробную информацию. 

Путь папки расширения: C:\ProgramData\Altium\Altium Designer <GUID>\Extensions\GOST BOM, 

где <GUID> – уникальный идентификатор установленного экземпляра Altium Designer.  

https://altium-ru.com/
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См. страницу Расширение функциональных возможностей Altium Designer документации Altium, чтобы 

подробнее узнать об установке расширений и управлении ими. 

 

Тестовый проект, демонстрирующий возможности модуля GOSTBOM: загрузить. 

Состав проекта (PrjDoc): 

 Схема (SchDoc) 

 Топология (PcbDOC) 

 Библиотеки (DBLib, SchLib, PcbLib, XLS) 

Проект содержит 7 групп элементов и 16 вариантов для более глубокого понимания возможностей Altium 

Designer. 

Группы можно скрывать директивой Compile Mask на листе схемы. 

Группы также подписаны на топологии. 

 

  

https://altium-ru.com/
https://www.altium.com/ru/documentation/altium-designer/extending-altium-designer
https://www.altium-ru.com/sites/default/files/attachments/Alternate_PRJ.zip
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 Интерфейс расширения 

После установки расширения, становятся доступны команды в подменю Reports » GOSTBOM  главного 

меню Altium Designer, когда открыт документ схемы (*.SchDoc) или документ платы (*.PcbDoc). Набор 

группы команд отличается в зависимости от активного документа (схемы или платы) – см. Таблица 2.1.  

Дополнительно к основному меню, для редактора схем и редактора платы становятся доступны 

соответствующие панели инструментов GOST BOM, отображение которых включается с помощью команды 

View » Toolbars » GOST BOM главного меню. 

 

Таблица 2.1 – Команды расширения и их функции. 

Иконка Наименование Описание Доступность 

команды 

 

Project Properties Добавление/изменение реквизитов  

проекта изделия 
Редактор схем 

Редактор плат 

 

Make List of Element Создать перечень элементов 

схемы электрической  
Редактор схем 

 

Make List of 

Purchased 
Создать ведомость покупных изделий 

на изделие 
Редактор схем 

Редактор плат 

 

Make Specification Создать спецификацию на изделие Редактор плат 

 

Documentation Группа команд для добавления данных в раздел 

«Документация» документа спецификации 
Редактор плат 

 

Materials Группа команд для добавления данных в раздел 

«Материалы» документа спецификации 

Редактор плат 

 

Kits Группа команд для добавления данных в раздел 

«Комплекты» документа спецификации 

Редактор плат 

 

CopyTemplates Распаковка и копирование шаблонов 

листов схем в папку шаблонов (Template location) 

Распаковка файла шрифта произодится в папку 

расширения 

Редактор схем 

 

Register Designator Группа команд для редактирования справочника 

буквенно-цифровых обозначений в электрических 

схемах на основе ГОСТ 2.710 

Редактор схем 

 

Name mode for 

GOSTBOM 
Группа команд формирования правил записи 

наименования и обозначения элементов изделия для 

соответствующих граф текстовых документов. 

Редактор схем 

Редактор плат 

 

  

https://altium-ru.com/
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 Установка шаблонов 

Централизованное управление идентификационными данными об изделии (реквизитами) и обеспечение 

их взаимного соответствия в формируемом наборе конструкторских документов осуществляется за счёт 

применения шаблонов листов схемы (*.SchDot) и текстовых документов (*.xls) с нормированным набором 

специальных строк (Parameters) для заполнения основной надписи документов в соответствии ГОСТ 2.104.  

 

Специальные строки действуют как заполнители информации о конструкции или системе, которая должна 

отображаться на схеме во время генерации выходных данных. Чтобы подробнее узнать об использовании 

специальных строк, см. страницу Text String документации Altium. 
 

Набор шаблонов листов схемы (*.SchDot) содержит основные форматы листов по ГОСТ 2.301 с соответствующей 

формой основной надписи по ГОСТ 2.104. Каждый шаблон в отдельности дополнительно содержит 

нормированный перечень специальных текстовых строк с настроенным типом и размером шрифта. 

Для установки шаблонов листов схемы выполните команду Reports » GOST BOM » Copy Templates ( ).  

Файлы шаблонов листов будут скопированы в папку, указанную в поле Template Location страницы Data 

Management – Templates диалогового окна Preferences. По умолчанию это папка 

C:\Users\Public\Documents\Altium\AD<номер_версии>\Templates. 

 
В случае удаления или переименования файлов шаблонов листов схем их можно выгрузить повторно, 

вызвав команду Copy Templates. 

Шаблоны текстовых документов (*.xls) распаковываются в папку расширения при первом формировании 

документа соответствующего типа. 

Полный набор шаблонов текстовых документов представлен на Рисунке 2.2. 

 
Рисунок 2.2 – Набор шаблонов текстовых документов 

Шаблоны текстовых документов содержат формы листов в соответствии с типом документов и нормированный 

набор специальных строк, необходимых для заполнения реквизитами основной надписи документов в 

соответствии ГОСТ 2.104, а также тип и размер шрифта в графах. 

 Установка шрифта 

Для корректного помещения записей в нормированные графы документов необходимо установить шрифт, 

который используется по умолчанию в шаблонах текстовых документов (*.xls) и листов схем (*.SchDot). 

После выполнения команды Copy Templates, в папку расширения распаковывается файл шрифта. Для 

установки шрифта в операционную систему откройте папку расширения через Проводник Windows, найдите 

файл шрифта (*.ttf), щёлкните по нему правой кнопкой мыши и в контекстном меню выберите команду 

Установить. 

После установки шрифта необходимо перезапустить Altium Designer. 

Подробнее об установке и удалении шрифтов Windows см. здесь. 

 

  

https://altium-ru.com/
http://docs.cntd.ru/document/1200045443/
https://www.altium.com/ru/documentation/altium-designer/sch-obj-textstringtext-string-ad#TextString-SpecialStrings
http://docs.cntd.ru/document/1200006582
http://docs.cntd.ru/document/1200045443/
http://docs.cntd.ru/document/1200045443/
https://support.microsoft.com/ru-ru/windows/установка-и-удаление-шрифта-в-windows-f12d0657-2fc8-7613-c76f-88d043b334b8
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 Общие требования к исходным данным 

Для формирования документов с помощью расширения GOSTBOM необходимо взаимное соответствие 

электрической схемы, топологии платы и состава изделия, а также заполненные значения параметров 

проекта и параметров компонентов. 

Все компоненты в рамках проекта должны иметь общие наименования параметров, которые необходимы 

для корректной обработки информации (сортировки, группировки, подсчёта и т.п.), необходимо наличие 

своего рода базы данных электронного описания изделия. 

 Настройка буквенных кодов компонентов 

Для адресации компонентов (элементов схемы и элементов конструкции) в проекте изделия в компонентах 

применяется системный параметр Designator (позиционное обозначение). 

 

Позиционное обозначение компонентов обеспечивает связь между конструкторскими документами 

комплекта с конструкцией изделия. Определение позиционного обозначения производится на схеме. 

Чтобы подробнее узнать об особенностях и возможностях аннотирования компонентов схемы в Altium 

Designer, см. страницу Аннотирование компонентов документации Altium. 

Позиционное обозначение строится из комбинации буквенных кодов и чисел. Нормирование буквенных 

кодов группами и видов компонентов производится согласно ГОСТ 2.710 и стандартам организации. 

В расширении GOSTBOM  для установки буквенных кодов применяется диалоговое окно ГОСТ 2.710 

Справочник буквенно-цифровых обозначений, вызываемое командой Reports » GOST BOM » Register 

Designator ( ) главного меню (Рисунок 2.3). По умолчанию справочник содержит набор буквенных кодов 

компонентов по ГОСТ 2.710, пользователю остаётся только сверить и при необходимости дополнить или 

изменить значения. 

 
Рисунок 2.3 – Команды управления справочником 

 

Компоненты объединяются в группы в документах на основе значения поля Группы/Вид элемента. 

Для сокращения количества групп, компонентам с разными буквенными кодами можно присваивать 

одинаковые значения Группы/Вид элемента, например: 

D – Микросхемы; DA – Микросхемы; DD – Микросхемы в ПЭ3 образуют группу Микросхемы. 

X – Соединители; XP – Соединители; XS – Соединители в ПЭ3 образуют группу Соединители. 
 

 
При наличии в проекте компонентов с буквенными кодами, не внесенных в справочник, эти компоненты 

не учитываются в формируемых текстовых документах. 

 

 

После первого вызова команды Register Designator, в папке расширения формируется файл настроек 

DesignatorDevice.xml. О возможности редактирования справочников через файлы *.xml см. 

раздел Редактирование справочников. 

  

 
Чтобы подробнее узнать о возможностях и особенностях управления библиотеками компонентов в Altium 

Designer, изучите страницы раздела Подробнее о компонентах и библиотеках документации Altium. 

https://altium-ru.com/
https://www.altium.com/ru/documentation/altium-designer/annotating-the-components-ad
http://docs.cntd.ru/document/1200001985
https://www.altium.com/ru/documentation/altium-designer/more-about-components-and-libraries-ad
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 Настройка наименования компонентов 

Для распознавания компонентов в проекте изделия применяется наименование. 

 

Наименование и позиционное обозначение обеспечивают взаимосвязь элементов изделия между 

документами комплекта конструкторской документации, конструкцией изделия и службами снабжения. В 

текстовых документах наименование изделия записывается в одноименную графу «Наименование». 

В Altium Desinger нет специального параметра для 

наименования, но часто применяется параметр Comment 

(Комментарий). Наименования компонентов могут быть 

представлены различными способами: одним параметром 

либо комбинацией нескольких параметров. В расширении 

GOSTBOM для определения наименования с помощью 

комбинации параметров применяется диалоговое окно 

Параметр - Наименование (Рисунок 2.14), вызываемое 

командой меню Reports » GOST BOM » Name mode for 

GOSTBOM ( ). 

По умолчанию, наименование соответствует параметру Comment. Для выбора пользовательского 

параметра, щелкните левой кнопкой мыши по ячейке в столбце Параметр ActiveBOM – будет открыт 

выпадающий список всего множества параметров компонентов, применённых в проекте. Для 

необходимости указания разделителя между отдельными параметрами, можно ввести любой набор 

символов в ячейку с столбце Разделитель. 

 

Согласно ГОСТ 2.106 запись наименования покупного изделия производится в соответствии с 

документами на его поставку с указанием обозначения этих документов, например: 

Микросхема 530ЛА16ММ АЕЯР.431200.140-10ТУ. 

Стандарты организации могут регламентировать запись наименования покупного изделия 

дополнительной справочной информацией: страна и/или фирма производителя, код корпуса, 

аутентичные обозначения и наименования на русском языке (для импортных изделий) и т.п., например: 

Микросхема 530ЛА16ММ АЕЯР.431200.140-10ТУ, Россия 

Микросхема 530ЛА16ММ АЕЯР.431200.140-10ТУ, Россия/ОАО "НИИМЭ И МИКРОН" 

Резистор 400102602K3902JBT [0805 39 кОм5% 0,2Вт] 

 

 

В случае если компоненты в проекте не имеют параметров с общим именем для определения 

наименования, то возможно два решения: исправить/добавить параметры (имя и значение) на уровне 

библиотеки либо сделать это на уровне проекта. Второй вариант является более быстрым и менее 

трудоёмким, решается с помощью инструмента Parameter Manager (Tools » Parameter Manager), который 

позволяет добавлять и редактировать общие параметры для всего множества компонентов проекта 

(Рисунок 2.5). Подробнее см. в разделе Добавление параметров множеству компонентов документации 

Altium. После определения нового параметра всему множеству компонентов его следует указать в 

GOSTBOM.  

 
Рисунок 2.5 – Добавление параметра для всех компонентов в проекте с помощью Parameter Manager 

 

 

После первого вызова команды Name mode for GOSTBOM, в папке расширения формируется файл 

настроек options.xml. О возможности редактирования справочников через файлы *.xml см. раздел 

Редактирование справочников. 

Рисунок 2.4 – Диалоговое окно 

Параметр - Наименование 

https://altium-ru.com/
https://www.altium.com/ru/documentation/altium-designer/understanding-models-components-and-libraries-ad#Добавление-параметров-множеству-компонентов
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3  ФОРМИРОВАНИЕ ДОКУМЕНТАЦИИ  

Текстовая конструкторская документация формируется поэтапно. На рисунке 3.1 представлен порядок 

формирования в рамках типового1 процесса проектирования изделия в Altium Designer. 
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1 Процесс проектирования в зависимости от особенностей объекта проектирования и стандартов 

предприятий может незначительно отличаться. 

Рисунок 3.1 – Формирование текстовой документации с применением расширения GOSTBOM в контексте типового 

процесса проектирования электронного модуля 

https://altium-ru.com/
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 Особенности подготовки проектных данных 

Электронное описание изделия в Altium Designer формируется расширением GOSTBOM при обработке 

данных схемы, а именно чтением всех элементов схемы (компонентов) и их параметров. Для группировки 

составных частей изделия используются специальные параметры. 

 Для определения вида специфицируемого изделия, компоненты должны содержать специальный 

параметр с именем Раздел, с одним из следующих значений согласно ГОСТ 2.106: Сборочная 

единица, Деталь, Стандартные изделия, Прочие изделия, Материалы.  

 По умолчанию все компоненты без параметра Раздел и с буквенными кодами принадлежат разделу 

Прочие изделия. 

 

При наличии в проекте компонентов с буквенными кодами в позиционных обозначениях, не внесенными 

в справочник, эти компоненты не учитываются в формируемых текстовых документах. Эта особенность 

позволяет дополнительно управлять составом изделия. Например, если необходимо в проекте обозначить 

компоненты, которые не учитываются в документе ПЭ3 (детали, сборочные единицы) укажите им буквенный 

код позиционного обозначения, не включенный в справочник. 

Ниже представлено поведение специфицируемой части вида изделия в текстовых документах в 

зависимости от наличия/отсутствия буквенного кода в справочнике на элемент схемы. 

Вид изделия Пример 

элемента 

Буквенный 

код 

ПЭ3 ВП Спецификация 

Сборочные 

единицы 
Трансформатор     

Детали Лепесток     

Прочие изделия Микросхема     

Стандартные 

изделия 
Лепесток     

Сборочные 

единицы 
Радиатор     

Детали Штанга     

Прочие изделия Резистор     

Стандартные 

изделия 
Винт     

 

 

При наличии в проекте вариантов (исполнений), компоненты первого варианта (базового) не должны иметь 

замен на альтернативные. В базовом варианте допускается значения компонентов только Fitted/Not 

Fitted. 

 

При наличии в проекте исполнений формируются групповые текстовые документы. Формирование 

текстовых документов для отдельного варианта не поддерживается. 

  

https://altium-ru.com/
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 Оформление реквизитов документов 

Для оформления основной надписи текстовых конструкторских документов, в расширении GOSTBOM 

используются параметры проекта. Значения этих же параметров применяются и для листов документов 

схем, при условии использования шаблонов листов (*.SchDot) из комплекта расширения GOSTBOM – см. 

раздел Установка шаблонов.  

Перечень косвенных параметров проекта для расширения GOSTBOM предопределен. Наименование 

параметров и их набор не подлежат редактированию. Список параметров приведен в разделе 

Приложение. Предопределенные параметры. 

 

Altium Designer поддерживает параметры на разных уровнях проекта – параметры уровня проекта, 

параметры уровня листа схемы и параметры уровня варианта. Они также имеют иерархию, что означает, 

что вы можете создать параметры с одинаковыми именами на разных уровнях проекта, каждый из которых 

имеет разные значения. Altium Designer применяется следующая иерархия: Вариант (самый высокий 

приоритет) → Документ схемы → Проект (самый низкий приоритет). Это означает, что значение параметра, 

определенное в документе схемы, переопределяет значение, определенное в параметрах проекта, а 

значение, определенное в варианте, переопределяет значение, определенное в документе схемы. 

Параметры уровня схемы недоступны на печатной плате или в спецификации – для этих типов документов 

следует использовать параметры проекта или варианта. 

Оформления основной надписи производится в диалоговом окне Свойства проекта (Рисунок 3.2), 

вызываемого командой Reports » GOST BOM » Project Properties ( ) главного меню. Команда доступна как 

из редактора схем, так и из редактора плат, для учёта поэтапного и ролевого характера проектных работ 

(инженер-разработчик → инженер-конструктор). Диалоговое окно Свойства проекта отображает в 

структурированном виде параметры активного проекта (Project » Project Options » Parameters, Рисунок 

3.3) и позволяет их редактировать. 

 
Рисунок 3.2 – Диалоговое окно Свойства проекта 

 

https://altium-ru.com/
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Рисунок 3.3 – Параметры проекта для заполнения основной надписи документа схемы,  

заданные с помощью диалогового окна Свойства проекта 

Диалоговое окно Свойства проекта включает в себя следующие разделы: 

 В разделе Фамилии ГОСТ 2.104 заполняются атрибуты: фамилии лиц согласно выполняемому 

характеру работ. Для ускорения процесса внесения фамилий в диалоговом окне Свойства проекта 

предусмотрены выпадающие списки фамилий на выбор. Подробнее о редактировании списков см. 

в разделе Редактирование справочников. 

 В разделе Сведения об изменениях документа ГОСТ 2.503 заполняются атрибуты: Порядковый 

номер изменения, Указания изменения, Номер документа изменения и Дата изменения. Сведения 

заполняются при необходимости для каждого документа отдельно. 

 В разделе Проект печатной платы ГОСТ 2.104 заполняются атрибуты: Обозначение, 

Наименование и литера и первичное применение на уровне электронного модуля (печатного узла). 

 В разделе Схема ГОСТ 2.701 заполняются атрибуты: Вид документа и Код документа Проекта, Раздел. 

 В разделе Плата печатная ГОСТ 2.123 заполняются атрибуты: Обозначение, Наименование, 

Формат чертежа на уровне печатной платы. 

 

Группы реквизитов Вид/Код Проекта, Раздел и Вид /Код Платы, Раздел являются справочными. 

Реквизиты введены для учёта данных о результатах проектирования печатной платы по ГОСТ 2.123-

93 и предусмотрены для документа спецификации на многослойные печатные платы. 

В текущих версиях этот вид документации не поддерживается. 
 

 

После первого вызова команды Project Properties, в папке расширения формируется файл настроек 

Settings.xml. О возможности редактирования справочников через файлы *.xml см. раздел 

Редактирование справочников. 

После заполнения реквизитов на уровне проекта осуществляется нумерация листов схем проекта с 

помощью диалогового окна Sheet Numbering For Project (Tools » Annotation » Number Schematic Sheets). 

 
Рисунок 3.4 – Диалоговое окно нумерации листов на уровне проекта 

  

https://altium-ru.com/
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 Общие особенности формирования текстовых документов 

Новые текстовые документы формируются в файлы формата *.xls, предоставляя возможность 

пользователю вносить изменения в документ. По умолчанию файлы документов сохраняются в папку 

выходных документов проекта, которая указывается в поле Output Path на вкладке Options диалогового 

окна Project Options (Project » Project Options, см. рисунок 3.5). По умолчанию это подпапка Project 

Outputs for <Имя проекта>, которая находится в папке проекта. 

 

После формирования документы автоматически 

добавляются в структуру проекта платы (*.PrjPcb), 

в раздел Other Documents (Рисунок 3.6). Для этих 

документов доступны все обычные операции по работе 

с документами. Открыть документ для его просмотра или 

печати или перейти к месту расположения папки можно 

через панель Projects, с помощью команд Open и Explore 

контексного меню соответственно. 

Имена файлов текстовых документов формируется 

автоматически как комбинация имени файла проекта и 

кода документа: 

 перечень элементов:  

<Имя файла проекта>_ПЭ3.xls; 

 ведомость покупных:  

<Имя файла проекта>_ВП.xls; 

 спецификация – <Имя файла проекта>.xls. 

 
 

 
При формировании документов система информирует об отсутствии файла печатной платы либо о наличии 

нескольких файлов печатной платы, но не останавливает процесс формирования документов. 
 

 

 
При повторной генерации отчета, в случае если файл невозможно перезаписать, выдается 

предупреждение, что файл используется другим процессом. Это может произойти, если, например, файл 

открыт в Excel. 

  

 
Правила наименования файлов жестко 

регламентированы системой. 

Определение имени выходных файлов через 

правила контейнера  в  документе Output Job File не 

поддерживается. 

Рисунок 3.5 – Определение пути сохранения всех выходных документов проекта 

Рисунок 3.6 – Расположение документов в 

структуре проекта 

https://altium-ru.com/
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 Перечень элементов 

Ниже представлена взаимосвязь граф текстового документа «Перечень элементов» c данными проекта. 

Altium Designer.  

Источник Component  

Altium Designer. Источник 

Project/ActiveBom 

Расширение GOSTBOM.  

Функция/команда 

«Перечень элементов» 

Графы документа 

 Designator Группировка ГОСТ 2.701, п.5.7 Поз. обозначение  

Parameters   Команда NameMode  Наименование 

  Группировка ГОСТ 2.701, п.5.7 Кол-во 

  Не используется Примечание  

Сформировать перечень элементов возможно двумя способами: через инструмент пакетного 

формирования файлов Output Job (подробнее см. раздел Формирование документации через OutJob) 

или с помощью команды Reports » GOST BOM » Make List of Element ( ) главного меню редактора схем. 

 Ведомость покупных изделий 

Согласно ГОСТ 2.106-96, составляют одну общую ведомость покупных изделий на изделие на основе данных 

всех спецификаций составных частей. Текущая возможность формирования ВП на отдельный печатный узел 

актуальна, если проект печатной платы является самостоятельным поставочным изделием. 

Ниже представлена взаимосвязь граф текстового документа «Ведомость покупных изделий» c данными 

проекта. 

Altium Designer.  

Источник Component  

Altium Designer. Источник 

Project/ActiveBom 

Расширение GOSTBOM.  

Функция/команда 

«Перечень элементов» 

Графы документа 

  Формирование номера по порядку № строки 

(параметр не определен) 

Parameters 

 
Команда NameMode  Наименование 

(параметр 

предопределен) 

ProductCode 

 
Группировка, сортировка 

ГОСТ 2.106, ГОСТ 2.113 

Код продукции  

Код ОКП 

(групповая ведомость) 

(параметр 

предопределен) 

StandardDoc 

 

Простая передача данных 
Обозначение документа 

на поставку 

(параметр 

предопределен), 

Manufacturer, 

ManufacturerCountry 

 

Простая передача данных Поставщик 

  Не используется Куда входит (обозначение) 

  Расчёт количества «Наименование» Кол-во 

 
 Группировка, сортировка 

ГОСТ 2.106 
На изделие 

  Не используется В комплекты 

  Не используется На регулир. 

  Формула шаблона *.xls(x) Всего 

  Группировка, сортировка 

ГОСТ 2.113 

Кол. на исполн. (групповая 

ведомость) 

Примечание  Простая передача данных Примечание 

https://altium-ru.com/
http://docs.cntd.ru/document/1200069439
http://docs.cntd.ru/document/1200069439
http://docs.cntd.ru/document/1200164121
http://docs.cntd.ru/document/1200001994/
http://docs.cntd.ru/document/1200164121
http://docs.cntd.ru/document/1200001994/
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Сформировать ведомость покупных изделий возможно двумя способами: через инструмент пакетного 

формирования файлов Output Job (подробнее см. раздел Формирование документации через OutJob) 

или с помощью команды Reports » GOST BOM » Make List of Purchased ( ) главного меню редактора схем 

или редактора плат. 

 

В документе ВП применяется сквозная нумерация покупных изделий, это позволяет более информативно 

работать с документом  

При наличии в изделии исполнений (вариантов проекта) формируется групповая ведомость покупных 

изделий. 

Для использования в проектах Multi-board вы можете самостоятельно настроить команды в интерфейсе 

приложения, используя диалоговое окно Customizing Editor. 

 Спецификация 

Извлечение информации о компонентах производится из механизма агрегации проектных данных 

ActiveBOM, даже если в структуре проекта отсутствует файл ActiveBOM. Этот механизм поставляет данные о 

компонентах следующих типов: Standard, Mechanical, Net Tie (In BOM), Jumper. 

Сформировать спецификацию возможно двумя способами: через инструмент пакетного формирования 

файлов Output Job (подробнее см. раздел Формирование документации через OutJob) или с помощью 

команды Reports » GOST BOM » Make Specification ( ) главного меню редактора плат. 

После формирования документа спецификации, расширением GOSTBOM предусмотрена возможность 

трансляции номеров позиций спецификации в значения столбца Line # документа в файл ActiveBOM 

(*.BomDoc), при его наличии в проекте. 

 Управление данными в разделах спецификации 

Команды для добавления данных в разделы спецификации доступны только в редакторе плат. Данные для 

разделов записываются непосредственно в проект, что в свою очередь позволяет вносить необходимые 

данные только один раз. 

Рисунок 3.7 – Группа команд для добавления данных в разделы спецификации. 

В ходе работы с расширением GOSTBOM вам может потребоваться внести изменения в списки доступных 

наименований документации, материалов и комплектов. Это можно выполнить, отредактировав файлы 

*.xml – см. раздел Редактирование справочников.  

 Раздел Документация 

Для формирования списка раздела «Документация» вызовите команду 

Reports » GOST BOM » Documentation ( ). 

 

Для добавления в спецификацию пользовательских объектов используйте сущности Custom Item и 

Custom Row, создаваемые инструментами ActiveBOM. 

См. страницу Управление составом изделия с ActiveBOM документации Altium, чтобы подробнее узнать 

об особенностях и возможностях работы с документом ActiveBOM. 

  

https://altium-ru.com/
https://www.altium.com/ru/documentation/altium-designer/client-dlg-customizeresourcesformcustomizing-editor-ad
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Рисунок 3.8 – Диалоговое окно Документация 

 

Рисунок 3.9 – Пример заполненного раздела «Документация» в спецификации 

 Раздел Материалы 

Для формирования списка раздела «Материалы» вызовите команду Reports » GOST BOM » Materials ( ). 

 

Рисунок 3.10 – Диалоговое окно Материалы 

https://altium-ru.com/
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Рисунок 3.11 – Пример заполненного раздела «Материалы» в спецификации 

 Раздел Комплекты 

Для формирования списка раздела «Комплекты» вызовите команду Reports » GOST BOM » Kits ( ). 

В прочих комплектах указывают программную продукцию (программное обеспечение), поставляемое 

вместе с изделием. Программная продукция (документы) могут быть объединены спецификацией по ГОСТ 

19.202. 

Если в состав комплекта входит не более трех наименований, то спецификацию комплекта можно не 

составлять, а изделия, входящие в комплект, должны быть записаны непосредственно в спецификацию 

соответствующего изделия в разделе «Комплекты». При этом наименование комплекта, к которому 

относятся вносимые в спецификацию изделия, записывают в графу «Наименование» в виде заголовка и не 

подчеркивают. 

 

Рисунок 3.12 – Диалоговое окно Комплекты 

 

https://altium-ru.com/
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 Трансляция позиций в сборочный чертёж 

После завершения редактирования топологии, добавления в проект печатного модуля документа ActiveBOM 

и генерации спецификации у инженера появляется возможность добавить позиционные обозначения на 

сборочном чертеже Draftsman (*.PCBDwf), определенные в спецификации.  

Алгоритм работы представлен на рисунке 3.13 ниже. 

 

Рисунок 3.13 – Схема обмена данными между документами BomDoc и PCBDwf 

Источником данных позиционных обозначений является спецификация, номера позиций автоматически 

записываются в документ ActiveBOM в поле Line # – см. рисунок 3.14.  

 

Рисунок 3.14 – Обновление позиций на чертеже 

После изменения состава проекта (добавление, удаление компонентов), для обновления позиций на 

чертеже потребуется повторная генерация спецификации и обновление сборочного чертежа с помощью 

команды Update Board главного меню Tools или контекстного меню рабочей области документа Draftsman. 

 
Так как ActiveBOM не добавляет печатную плату в список комплектующих изделий печатного модуля, 

пользователю предлагается проставлять номер позиции печатной платы вручную. 
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 Формирование документации через OutJob 

Для централизованного выпуска текстовых документов с помощью файла Output Job (*.OutJob) 

необходимо произвести предварительную настройку этого файла. 

В разделе Outputs в группе Report Outputs добавьте отчет (источник вывода), выбрав пункт GOST BOM 

(Рисунок 3.15, п.1). Далее для добавленного отчета, используя команду Configure в контекстном меню 

(Рисунок 3.15, п.2), в открывшемся диалоговом окне Отчеты GOSTBOM выберите формируемые документы 

(Рисунок 3.15, п.3). Далее в разделе Output Container добавьте контейнер(ы) Folder Structure для 

источников вывода (Рисунок 3.15, п.4) и задайте его настройки (команда Properties в контекстном меню). 

После этого запустите команду Tools » Run, когда контейнер выделен, для формирование отчётов (Рисунок 

3.15, п.5). 

 
Рисунок 3.15 – Порядок настройки файла OutJob для выпуска документов 

  

 
Чтобы подробнее узнать о пакетном формировании выходных документов с помощью файлов Output Job, 

перейдите на страницу Подготовка множества выходных документов в OutputJob документации Altium. 

https://altium-ru.com/
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 Печать или экспорт в PDF 

Использование документов в документообороте на предприятиях производится как в бумажной, так и в 

электронном виде. Электронные документы представлены файлами в формате PDF. Бумажные документы 

являются результатом выводом на печать файлов формата PDF. 

Дополнительная причина печати документа из файла PDF, а не из файлов форматов Excel – это избежание 

проблем приложения Excel, которое может некорректно  автоматически работать с драйвером принтера, а 

именно неправильно определять размер полей бумаги в принтере, считывая выбранный размер бумаги с 

настроек в драйвере принтера. 

Для преобразования файла в представление формата PDF, предлагается следующий вариант (см. рисунок 

3.16): откройте файл в Microsoft Excel, выберите команду Файл » Сохранить как главного меню и 

задайте тип файла PDF (*.pdf). В диалоговом окне Параметры укажите Не учитывать область печати. 

Сохраните документ. 

При необходимости печати текстового документа в бумажную копию откройте сформированный файл в 

формате PDF и отправьте на устройства вывода (принтер или плоттер). 

 
Рисунок 3.16 – Настройка параметров печати файла *.xlsx в формат *.pdf 

 

https://altium-ru.com/


1996». Руководство пользователя. 

www.altium-ru.com Copyright © 2020 Altium Limited  24 

 

Расширение 

GOST 2.701-2008/2.106-1996 

Руководство пользователя 

Программный модуль 

GOST 2.701-2008/2.106-1996 

Руководство пользователя 

 

4  РЕДАКТИРОВАНИЕ  СПРАВОЧНИКОВ  

В расширении GOSTBOM основные настройки и справочники организованы в виде файлов *.xml, которые 

можно редактировать в любом текстовом редакторе. Порядок записей в XML-файле определяет порядок 

записей в соответствующих диалоговых окнах. Внесённые изменения вступают в силу после сохранения 

файлов и перезапуска соответствующих команд. 

 Файл DesignatorDevice.xml 

Файл DesignatorDevice.xml содержит буквенные коды групп видов компонентов. Этот файл 

формируется в папке расширения после вызова команды Reports » GOST BOM » Register Designator. 

Для данного справочника предусмотрен графический интерфейс – диалоговое окно ГОСТ 2.710 Справочник 

буквенно-цифровых обозначений, вызываемое командой Reports » GOST BOM » Register Designator. 

 
Рисунок 4.1 – Фрагмент синтаксиса файла DesignatorDevice.xml 

 Файл Settings.xml 

Файл Settings.xml содержит значения атрибутов диалогового окна Свойства проекта для выпадающих 

списков. Предопределение значений этого набора позволяет ускорить заполнение атрибутов. Этот файл 

формируется в папке расширения после вызова команды Reports » GOST BOM » Project Properties. 

 
Рисунок 4.2 – Фрагмент синтаксиса файла Settings.xml 

 Файл Options.xml 

Файл Options.xml содержит синтаксис правила «полного наименования» изделий в КД. Этот файл 

формируется в папке расширения после вызова команды Reports » GOST BOM » Name mode for 

GOST BOM. 

Для изменения и выбора параметра, по которому будут формироваться текстовые документы, измените 

файл options.xml. Настройки в файле options.xml позволяют создать составное наименование: 
<Parameter Key="Новый параметр" Separator="Новый разделитель" /> 

Для данной настройки предусмотрен графический интерфейс – диалоговое окно 

Параметр - Наименование, вызываемое командой Reports » GOST BOM » Name mode for GOST BOM. 
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Рисунок 4.3 – Фрагмент синтаксиса файла Options.xml 

 Файл DefaultValues.xml 

Файл DefaultValues.xml содержит набор часто применяемых значений в виде выпадающих списков для 

диалоговых окон Документация, Комплекты и Материалы. Редактирование этого набора позволяет 

ускорить процесс наполнения разделов документации. Этот файл формируется в папке расширения после 

вызова команды Reports » GOST BOM » Make Specification. 

 
Рисунок 4.4 – Фрагмент синтаксиса файла DefaultValues.xml 
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ЧАСТО ЗАДАВАЕМЫЕ ВОПРОСЫ  

Почему после установки Altium Designer, команды расширения GOSTBOM не отображаются в 

редакторах? 

Расширение GOSTBOM не устанавливается вместе с Altium Designer по умолчанию, его необходимо 

установить отдельно. См. раздел Установка расширения. 

Почему расширения GOSTBOM нет в списке доступных расширений на вкладке Purchased страницы 

Extensions & Update? 

Проверьте, что на странице System - Installation диалогового окна Preferences корректно задан источник 

установки. 

 При использовании онлайн-установки (опция Global Installation service) убедитесь, что выполнен 

вход в учетную запись Altium. 

 При использовании офлайн-установки (опция Offline installation) убедитесь, что задан корректный 

путь к папке офлайн-установщика Altium Designer. 

Возможно ли формировать перечень элементов для иерархических проектов? 

Формирование перечня элементов с делением на функциональные группы не поддерживается. 

Почему в документе перечень элементов не учитываются компоненты с типом Standard (No BOM)? 

Текстовые документы формируются как отчеты из редактора ActiveBOM, который поддерживает только 

компоненты для закупки, т.е. компоненты со следующими значениями параметра Type: Standard, 

Mechanical, Net Tie (In BOM), Jumper. 

Возможно ли формировать текстовые документы для отдельных исполнений в многовариантных 

проектах? 

Формирование текстовой документации для проектов с исполнениями поддерживает только групповые 

документы.  

Формирование текстовых КД отдельно для исполнения не поддерживается. 

Как учитывать в проекте компоненты, подбираемые при регулировании (ГОСТ 2.702 п.5.3.27)? 

Учет компонентов, подбираемых при регулировании, в Altium Designer возможен через пользовательские 

объекты (Custom Item) в документе ActiveBOM (*.BomDoc). 

Созданные документы при печати на принтере не соответствуют формату листа. Как правильно 

распечатать на принтере сформированные документы? 

Обязательно необходимо наличие установленного шрифта, применённого в шаблонах Exсel. 

Вывод на бумажный носитель предлагается выполнять по следующему сценарию: 

a) документы формируются в формате *.xlsx, по необходимости вносятся дополнительные данные.  

b) документы формата *.xlsx встроенными функциями Excel сохраняются в формат *.pdf.  

c) документы формата *.pdf печатаются встроенными функциями применяемого ПО для просмотра 

файлов PDF. 

Почему в формируемых документах отсутствует лист регистрации изменений? 

В соответствии с ГОСТ, лист регистрации изменений добавляется при количестве листов более трёх. 

Как в документах ПЭ3 и ВП автоматически записывать информацию в поле "Примечание"? 

Автоматическое заполнение поля примечание не поддерживается.  

https://altium-ru.com/
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Где находятся шаблоны текстовых документов GOSTBOM? 

Шаблоны текстовых документов (*.xls) распаковываются в папку расширения при первом формировании 

документа соответствующего типа. Папка расширения: C:\ProgramData\Altium\Altium Designer 

<GUID>\Extensions\GOST BOM, где <GUID> – уникальный идентификатор установленного экземпляра 

Altium Designer. 

Возможно ли установить пользовательский шрифт в шаблонах текстовых документов (*.xls)? 

Изменение шрифтов не рекомендуется, так как размерность граф регламентирована и все символы в 

надписи могут не поместится, соответствено, в случае замены шрифта, при печати на бумажный носитель 

размеры форматов могут не соответствовать требованиям ГОСТ. 
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ПРИЛОЖЕНИЕ. ПРЕДОПРЕДЕЛЁННЫЕ ПАРАМЕТРЫ  

Ниже приведены предопределённые параметры, используемые расширением GOSTBOM. 

Параметры уровня проекта (Project » Project Options » Parameters) определяются в диалоговом окне 

Свойства проекта (Reports » GOST BOM » ProjectProperties). 

Имя параметр проекта Пример заполнения 
Применяемость 

Схема ПЭ3 ВП Спецификация 

п_Разраб_Р Разраб     

п_Пров_Р Сх_Пров.     

п_Н_контр_Р Сх_НКонтр.     

Характер_работы Рук.Проекта     

п_Доп_графа_Р Сх_РПроекта     

п_Утв_Р Сх_ Утв.     

п_Разраб К_Разраб.     

п_Пров К_Пров.     

п_Н_контр К_НКонтр.     

п_Т_Контр К_ТКонтр.     

п_Доп_графа К_РПроекта     

п_Утв К_Утв.     

Порядковый_номер_изменения      

Указания_изменение      

Номер_документа_изменение      

Дата_изменения      

Порядковый_номер_изменения_ПЭ3      

Указания_изменение_ПЭ3      

Номер_документа_изменение_ПЭ3      

Дата_изменения_ПЭ3      

Порядковый_номер_изменения_ВП      

Указания_изменение_ВП      

Номер_документа_изменение_ВП      

Дата_изменения_ВП      

Порядковый_номер_изменения_СП      

Указания_изменение_СП      

Номер_документа_изменение_СП      

Дата_изменения_СП      

Проект Входимость Проект>Изделие>Блок>ФУ     

Наименование Полное наименование для трёх строк     

Наименование1 Разделенное      

Наименование2 наименование     

Наименование3 для трёх строк     

Литера Э     

https://altium-ru.com/
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Имя параметр проекта Пример заполнения 
Применяемость 

Схема ПЭ3 ВП Спецификация 

Литера2 Т     

О1 О1     

ПервПримен АБВГ.468361.100     

Обозначение АБВГ.468361.500     

Код_документа Т6М     

Вид_документа Файл проекта печатной платы     

Раздел Документация     

Код_документа_SCH Э3     

Обозначение_Код ХХХХ.468361.001Э3     

Вид_документа_SCH Схема электрическая принципиальная     

Раздел_SCH Документация     

Обозначение_PCB XXXX.758723.001     

Наименование_PCB Плата печатная     

Формат_PCB А3     

Код_документа_PCB Т5М     

Вид_документа_PCB Файл печатной платы     

Раздел_PCB Деталь/Сборочные единицы     

Документация0 Формат#Обозначение#Вид документа 

#Код#Примечание#порядковый номер 

    

….     

Документация2 
А3#ХХХХ.468361.001#Сборочный 

чертеж#СБ##2 
    

Материалы0 Материал #Колличество#Ед. изм.# 

Примечание# порядковый номер 

    

….     

Материалы2 Лак УР-231 ТУ6-10-863-76.9.3#0,1#л##2     

Комплекты0 Формат#Обозначение#Вид 

документа#Код#Примечание#порядковый 

номер 

    

….     

Комплекты2 
# ХХХХ.468361.001#Управляющая 

программа#ПО#ЭН#2 
    

Параметры уровня листа схемы определяются для активного документа схемы на вкладке Parameters 

панели Properties в режиме Document Options. 

=Наименование_организации отображает значение, указанное для первых листов схемы, при 

необходимости. 

=SheetNumber – номер листа текущего документа схемы. 

=SheetTotal – общее количество листов схемы по проекту. 

 
Параметры нумерации листов документа схемы на уровне проекта определяются в диалоговом окне 

Sheet Numbering For Project, вызываемом командой Tools » Annotation » Number Schematic Sheets.  

https://altium-ru.com/
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ПРИЛОЖЕНИЕ. НОРМАТИВНЫЕ ДОКУМЕНТЫ  

В своей работе расширение GOSTBOM учитывает требования, правила и нормы следующих стандартов: 

ГОСТ 2.001-2013  ЕСКД. Общие положения 

ГОСТ 2.004-88 ЕСКД. Общие требования к выполнению конструкторских и технологических 

документов на печатающих и графических устройствах ЭВМ 

ГОСТ 2.051-2013 ЕСКД. Электронные документы. Общие положения 

ГОСТ 2.052-2015 ЕСКД. Электронная модель изделия. Общие положения 

ГОСТ 2.053-2013 ЕСКД. Электронная структура изделия. Общие положения 

ГОСТ 2.054-2013 ЕСКД. Электронное описание изделия. Общие положения 

ГОСТ 2.055-2014 ЕСКД. Электронная спецификация. Общие положения 

ГОСТ 2.102-2013 ЕСКД. Виды и комплектность конструкторских документов 

ГОСТ 2.103-2013 ЕСКД. Стадии разработки 

ГОСТ 2.104-2006 ЕСКД. Основные надписи 

ГОСТ 2.106-96 ЕСКД. Текстовые документы 

ГОСТ 2.111-2013 ЕСКД. Нормоконтроль 

ГОСТ 2.113-75  ЕСКД. Групповые и базовые конструкторские документы 

ГОСТ 2.123-75 ЕСКД. Комплектность конструкторских документов на печатные платы 

при автоматизированном проектировании 

ГОСТ 2.201-80 ЕСКД. Обозначение изделий и конструкторских документов 

ГОСТ 2.301-68 ЕСКД. Форматы 

ГОСТ 2.413-72 ЕСКД. Правила выполнения конструкторской документации изделий, 

изготовляемых с применением электрического монтажа 

ГОСТ 2.503-2013 ЕСКД. Правила внесения изменений 

ГОСТ 2.701-2008 ЕСКД. Схемы. Виды и типы. Общие требования к выполнению 

ГОСТ 2.702-2011 ЕСКД. Правила выполнения электрических схем 

ГОСТ 2.710-81 ЕСКД. Обозначения буквенно-цифровые в электрических схемах 

РД 107.2.1002-89  Номенклатура и коды прочих документов и инструкций 

ОСТ4.000.030-85  Конструкторская документация. Выполнение спецификаций 

ГОСТ 14.206-73  Технологический контроль конструкторской документации 

ГОСТ 34.320-96  Информационные технологии. Система стандартов по базам данных. 

Концепции и терминология для концептуальной схемы и информационной базы 

ГОСТ Р ИСО/МЭК 

ТО 10032-2007  

Эталонная модель управления данными 
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Designer®, Altium Vault®, Autotrax®, Camtastic®, Ciiva™, CIIVA SMARTPARTS®, CircuitMaker®, CircuitStudio®, Codemaker™, Common Parts Library™, Draftsman®, 

DXP™, Easytrax®, NanoBoard®, NATIVE 3D™, OCTOMYZE®, Octopart®, P-CAD®, PCBWORKS®, PDN Analyzer™, Protel®, Situs®, SmartParts™, ряд компиляторов 
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Компания Altium, основанная в 1985 году, имеет офисы по всему миру, в городах Сан-Диего, Бостон и Нью-Йорк в США, в городах Карлсруэ, Амерсфорт, 
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